# Table of Contents

**Overview** ...................................................................................................................................................... 4
- Roles in ImageNow ................................................................................................................................... 4
- What are documents and projects? ........................................................................................................... 5
- About ImageNow components .................................................................................................................. 5

**Terminology** .............................................................................................................................................. 6
- About the ImageNow toolbar ................................................................................................................. 6
- About the WebNow toolbar ....................................................................................................................... 7
- About the ImageNow or WebNow Explorer window ................................................................................. 7
- About ImageNow and WebNow Viewer .................................................................................................... 9
- About document keys .............................................................................................................................. 10
- About custom and composite properties ................................................................................................. 10
- About pages ............................................................................................................................................ 10

**About Document Processing** ................................................................................................................ 11
- About scanning ........................................................................................................................................ 11
  - Capture a document using a scanner in single mode ......................................................................... 11
  - Capture a document using a scanner in batch mode ......................................................................... 11
- About quality assurance .......................................................................................................................... 12
  - Quality assure a document or batch .................................................................................................... 12
- About linking ............................................................................................................................................ 13
  - Link a document or batch ..................................................................................................................... 13
- About merging ......................................................................................................................................... 13
- About modifying document keys and custom properties ......................................................................... 14
  - Modify document key values ............................................................................................................... 14
  - Edit custom properties ......................................................................................................................... 14
- About deleting and restoring documents ................................................................................................. 14
  - Delete a document ............................................................................................................................... 15
  - Restore a document ............................................................................................................................. 15
- About sending documents ....................................................................................................................... 15
  - About emailing documents ............................................................................................................... 15
  - About faxing documents ...................................................................................................................... 16
- About sending documents to ImageNow Viewer ..................................................................................... 16
  - Export a document to a file ................................................................................................................ 16

**About Retrieving and Viewing** .............................................................................................................. 18
- What is a condition? ............................................................................................................................... 18
Overview

ImageNow is a content management software system that adapts to your business process. It uploads, organizes, and stores documents and content. ImageNow ensures that all documents are secure, quickly retrievable, and tied to the files and applications you want, with comments and annotations as needed. It can capture and manage data from emails, reports, and non-image file formats such as DOC and TXT. In ImageNow, you can assign tasks to users, move documents to users through a workflow, and more.

This guide describes the overall concept of ImageNow and WebNow. It also explains step-by-step procedures of common functions a user may need to perform.

This guide contains the following sections:

- **“Overview”** introduces ImageNow and WebNow.
- **“Terminology”** defines the common terminology and labeling used in ImageNow and WebNow.
- **“Capture and Store Documents”** provides information about importing, storing, and organizing documents.
- **“Retrieve and View Documents”** defines the terminology associated with searching. This section also provides step-by-step instructions for performing different types of searches.
- **“Send Documents to Workflow”** gives a basic description of workflow, and steps that an end-user can perform when working with documents in a workflow.
- **“Perform Actions on a Document”** describes basic actions an end-user can perform on a document such as tasks, annotations, and redactions.
- **“Additional Functionality”** provides conceptual information about additional functionality that requires additional licenses in ImageNow.

This document provides introductory information only. More specialized topics on working in ImageNow and WebNow appear on the Perceptive Software website, in the Customer Portal, under Product Documentation.

Roles in ImageNow

The way you interact with ImageNow varies depending on your role and business process. The following roles work together to complete business processes in ImageNow:

- **Administrator** – This user has owner or manager privileges in ImageNow. This person accesses Management Console by clicking Manage on the ImageNow toolbar to configure ImageNow to match your business processes. The administrator’s responsibilities may include assigning privileges, creating application plans, creating custom properties, adding users to groups, and more.
- **End user** – This user works in ImageNow or WebNow completing daily tasks associated with a business process. This person can complete actions such as capture, sign, create new documents and projects.
- **Developer** – This person can create iScript as well as other custom script to customize aspects of ImageNow in order to tailor the functionality to match very specific scenarios in a business process.
What are documents and projects?

ImageNow stores and organizes files as one of the following information types:

- **Documents** – A document is a set of scanned images or imported files or both, along with the metadata (such as index keys) that make it easy to search for the document. A document can contain many different file formats. TIFF, DOCX, and PNG are just a few of the accepted file types. A document appears in ImageNow Viewer or WebNow Viewer.

- **Projects** – Projects group related documents independently of the index keys assigned to them.

About ImageNow components

The ImageNow suite contains three primary components:

- **ImageNow** – Adapts to your business processes and ensures that all documents are secure, quickly retrievable, and tied to the files and applications you want, with comments and annotations as needed.

- **WebNow** – Provides a browser-based solution. WebNow works with ImageNow to instantly deliver to your browser secure, digital versions of paper or other electronic documents associated with your workflow activities or application software transactions.

- **Management Console** – The ImageNow Management Console enables ImageNow administrators to configure ImageNow users, groups, privileges, and so on.
**Terminology**

This section describes the labels and terminology used in ImageNow and WebNow.

**Using toolbars**

After you log in to ImageNow or WebNow, a toolbar appears. From this toolbar, all of the functions and documents you need are only one mouse click away.

**About the ImageNow toolbar**

The ImageNow toolbar lets you configure the appearance such as toolbar size, button size, and button text. All of the functions and documents you need are only one mouse click away. The options below change depending on your security privileges. The ImageNow toolbar provides access to all ImageNow functions.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Clicking the button lets you</th>
<th>Clicking the arrow lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td>🛡️</td>
<td>Applications</td>
<td>Display ImageNow Explorer with the Find a Document pane for the currently selected application plan.</td>
<td>Select an application plan from the list and display ImageNow Explorer with the Find a Document pane for that application plan.</td>
</tr>
<tr>
<td>📄</td>
<td>Batches</td>
<td>Display ImageNow Explorer for all document batches.</td>
<td>Select all batches, only batches ready for QA or only batches ready for linking.</td>
</tr>
<tr>
<td>📄</td>
<td>Documents</td>
<td>Display ImageNow Explorer, where you can search for documents.</td>
<td>Select a predefined document view.</td>
</tr>
<tr>
<td>📄</td>
<td>Projects</td>
<td>Display ImageNow Explorer, where you can search for projects.</td>
<td>Select a predefined project view.</td>
</tr>
<tr>
<td>📄</td>
<td>Reports</td>
<td>Display ImageNow Explorer, where you can view reports.</td>
<td>Select a report or a report folder.</td>
</tr>
<tr>
<td>🔴</td>
<td>Tasks</td>
<td>Display the ImageNow Explorer for any tasks assigned to you.</td>
<td>Select a particular type of task.</td>
</tr>
<tr>
<td>🌟</td>
<td>Workflow</td>
<td>Display the ImageNow Explorer for any workflow queues that contain documents.</td>
<td>Select a specific workflow and queue.</td>
</tr>
<tr>
<td>📷</td>
<td>Capture</td>
<td>Start the default capture profile.</td>
<td>Start any capture profile in the list.</td>
</tr>
</tbody>
</table>

*Note* The Reports button only appears if you have a valid Business Insight license.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Clicking the button lets you</th>
<th>Clicking the arrow lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Manage</td>
<td>Open Management Console.</td>
<td>No arrow appears.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The Manage button only appears if you have management privileges.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Help</td>
<td>Display online help for the ImageNow product you are currently viewing.</td>
<td>Display online help for any ImageNow product in the list.</td>
</tr>
</tbody>
</table>

**About the WebNow toolbar**

The WebNow toolbar and links provide access to all WebNow functions. The buttons shown below may change depending on your security privileges and purchased licenses.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Clicking the tool lets you</th>
<th>Clicking the arrow lets you</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Documents</td>
<td>Select document views in the Views pane.</td>
<td>Select a document view.</td>
</tr>
<tr>
<td></td>
<td>Projects</td>
<td>Select project views in the Views pane.</td>
<td>Select a project view.</td>
</tr>
<tr>
<td></td>
<td>Reports</td>
<td>Select reports in the Views pane.</td>
<td>Select a report or report folder.</td>
</tr>
<tr>
<td></td>
<td>Tasks</td>
<td>Select task views in the Views pane.</td>
<td>Select a task view.</td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
<td>Select workflow in the Views pane.</td>
<td>Select a workflow process.</td>
</tr>
<tr>
<td></td>
<td>Capture</td>
<td>Import files into WebNow.</td>
<td>Not applicable.</td>
</tr>
</tbody>
</table>

**About the ImageNow or WebNow Explorer window**

The Explorer windows display document and project information in grids. A grid, in turn, displays a list of documents filtered based on the type of grid you select. In ImageNow Explorer, depending on your security privileges, you can view all of the ImageNow grids, including application plans, batches, documents, projects, tasks, and workflow queues. Each row in the grid represents a document that resides in ImageNow or is in an intermediate status such as QA or Linking. You can view the document or perform actions on it by double-clicking its row.
You can use the toolbar buttons to open, email, print, add notes to, refresh, delete, or display the properties of the selected document. You can also reposition any of the toolbars to the top, left, right, or bottom side of the Explorer grid.

In the Views pane, you can switch between following types of grids:

- **Application Plans** view displays the documents that are linked to records in an external business application, such as AP, HR, or student records management.
- **Batches** view displays one or more groups of pages that are ready for QA or Linking.
- **Documents** view displays the documents that satisfy the document views and filters defined for your user account.
- **Projects** view displays the projects that satisfy the project views and filters defined for your user account. Double-clicking a project row displays the documents in the project.
- **Reports** view displays the folders and reports accessible to you. Clicking a report folder displays the reports and subfolders associated with it.
- **Tasks** view displays the documents associated with the various task types that a manager assigns to you, for example, To Review, Returned to Me, or Complete.
- **Workflow** view displays any documents that reside in the workflow and queue you select in the tree.
About ImageNow and WebNow Viewer

ImageNow and WebNow Viewers enable you to see the content of your documents. The viewer appears when you double-click a document in the ImageNow or WebNow Explorer window. The Page pane displays a resizable view of the document you opened.

In addition to displaying the document, ImageNow or WebNow Viewers can also display information about the document in the following panes that appear when you select them in the View menu:

- In the Actions pane, you can perform actions on the document such as emailing the document, exporting the document to a file, faxing or printing the document, editing the documents properties, digitally signing the document, adding the document to a project or workflow, or launching the application that is associated to the document.
  
  If the selected document is in version control, the Actions pane includes an additional section that allows you to check out or check in the document, view version history of the document, and remove the document from version control.

- In the Contents Search Results pane, if you have a licensed Content Server, the results of the most recent full-text search appear. The pane lists all pages in a TIFF, GIF, BMP, or JPG document where the search string appears. You can display these pages sequentially by clicking the Next or Previous button, or you can display a specific page by double-clicking a row in the list.

- In the Digital Signatures pane, if you have a Document Management license, you can view the details of any signatures on the document.

- In the Forms pane, you can view electronic forms that allow you to capture additional data for the document. You can then type data into the fields on the form you select.

- In the Properties pane, you can display and update the document keys and custom properties that describe and define the document. You can also add a note to the document or update an existing note.

- In the Related Documents pane, you can select a view in the Relationship list. The relationship view then runs automatically and shows all of the documents in ImageNow that satisfy the conditions defined in the related view.

- In the Tasks pane, you can view the document-related tasks assigned to you as well as complete, return, or temporarily skip a task.

- In the Thumbnails pane, you can double-click a different page of a multiple-page document to display it in the Page pane.

Depending on your privileges and the format of the document in the Page pane, you can perform additional functions, such as rotating, smoothing, inverting, or annotating, by selecting items in the View menu or clicking buttons on the toolbars.

Note You can open a maximum of nine document viewers and project viewers (combined) at one time.
About document keys

Document keys are the values that ImageNow users leverage to store, secure, and retrieve captured documents in ImageNow. Six document key fields (also called index keys) are available for use in ImageNow – Drawer, Folder, Tab, Field 3, Field 4, and Field 5. The first field, Drawer, is used to separate large groups of captured objects. Document type is a document key that categorizes a document according to a predefined list of values, which makes it similar to the drawer document key. Security can be applied to a drawer in order to allow access only to certain users. These document key fields are customizable to fit any business model.

About custom and composite properties

Custom properties let you store additional data to describe a document beyond the standard document keys. A composite property is a single property that contains one or more custom properties.

An ImageNow administrator can create custom and composite properties and then associate them with document types or project types to make these properties available. An end-user can enter data in, view, or search on created and associated custom properties.

Note Creating and managing custom properties requires the Manage Custom Properties privilege unless you are an ImageNow administrator.

About pages

In addition to document keys, custom properties, and document properties, ImageNow documents normally consist of one or more pages. A page represents an image captured by a scanner or a file imported from your file system. You usually scan pages to TIFF files. You can import pages in any file format, and pages in different formats can reside in a single document. For example, your imported document might contain several pages in Microsoft Word format and additional pages in PDF and XSL format.

To view the number of pages in a document, open a view or filter in ImageNow Explorer and inspect the Pages column, open a document and view the Thumbnails pane in ImageNow Viewer, or check the document properties. When granted the appropriate drawer or document type privileges, you can manage pages with the following actions:

- Copy all the pages from one document to another. This action gives you the option of replacing all pages in the destination document or appending them to the existing pages.
- Copy selected pages from one document to another. This action appends the copied pages to the pages of the destination document.
- Append a page from a scanner or a disk file to an existing document.
- Add an addendum to a document.
- Move pages within a document.
- Move pages from one document to another.
- Delete pages.
About Document Processing

Processing documents involves three essential tasks for importing documents and any unstructured data into ImageNow and then integrating the documents and data with your business application.

- First, you scan or import a document to capture it in ImageNow.
- Next, you review each document to ensure the quality of the captured documents.
- Last, you link the document to document keys (which may include custom or composite properties) to group the documents in a logical order and match them to records in your business application.

After users complete the previous steps and process the document successfully, you can use other document features such as searching, viewing, merging, printing, and exporting.

About scanning

ImageNow offers three methods of scanning and importing documents. With appropriate privileges, you can:

- Scan each document one-by-one basis using the Single Mode method.
- Scan several documents at a time using the Batch Mode method.
- Scan or update baskets of documents using the Package Mode method.

Each method allows you to bypass QA by sending documents directly to a workflow and assigning document keys to.

Capture a document using a scanner in single mode

1. Load the document you want to scan into the document feeder.
2. On the ImageNow toolbar, click the Capture down arrow and then click to select the capture profile you want where Scanner is the source and your mode is Single.
3. In ImageNow Viewer- Single Scan, verify image quality, make any changes you want using the options available to you and then perform one of the following actions:
   - Click Save Scanned Image.
   - Click Rescan Page, click the capture profile name, and then repeat scanning steps.
   - Click Discard Scanned Image.

Capture a document using a scanner in batch mode

1. Load the documents you want to scan into the document feeder.
2. On the ImageNow toolbar, click the Capture down arrow and then click to select the capture profile you want where Scanner is the source and your mode is Batch.
3. Optional. If you specified Validate page count as a batch option when creating the capture profile, the Pre-Scan Worksheet dialog box prompts you to select Prep User name, Prep Date, and Pages. Select or enter the values you want and then click OK.
4. Optional. In your capture profile, if you selected the Show Batch Report check box, three values appear in the Batch report dialog box: the Local Batch ID, Pages scanned, and Pages discarded. Click OK.
5. On the ImageNow toolbar, click Batches, and then double-click the batch you just scanned to begin the quality assurance and document linking process.
About quality assurance

After you scan your documents, review them to ensure they are correct and complete.

Quality assure a document or batch

1. On the ImageNow toolbar, click Batches and then, in the Views pane, click Ready for QA.
2. In the grid, select the batch you want to quality assure.
3. On the File menu, click Open.
4. In the ImageNow Viewer, inspect the page. It is acceptable when it meets most or all of the following standards:
   - The scanned or imported image resembles the original document.
   - No part of the page is missing due to a scanner misfeed.
   - All critical elements of the document are legible (for example, signatures, account numbers, and totals).
   - The document is properly oriented and aligned.
5. On the ImageNow Viewer toolbar, click one of the following buttons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mark page as OK" /></td>
<td><strong>Mark page as OK.</strong> If the batch was a single page document, you are returned to the ImageNow Explorer. If you are quality assuring a multi-page batch, the next page of the document appears, and you must click <strong>Mark page as OK</strong> until you complete QA on all pages in the batch.</td>
</tr>
<tr>
<td><img src="image" alt="Rescan page" /></td>
<td><strong>Rescan page.</strong> Rescan a page if it does not meet your standards of quality. Locate the original document and either place it back into the scanner feed or reimport it from a file system.</td>
</tr>
<tr>
<td><img src="image" alt="Commit batch" /></td>
<td><strong>Commit batch.</strong> Choose this option if you want to QA the batch without looking at all pages.</td>
</tr>
<tr>
<td><img src="image" alt="Suspend batch" /></td>
<td><strong>Suspend batch.</strong> Choose this option if you want to review another batch and conclude the current QA session later.</td>
</tr>
<tr>
<td><img src="image" alt="Delete batch page" /></td>
<td><strong>Delete batch page.</strong> Discard the page if you want to remove it from the batch and the ImageNow server. If, instead, you want to replace it with a newly scanned version, click <strong>Rescan page.</strong></td>
</tr>
</tbody>
</table>
About linking

You link quality assured documents to records in your business application. Linking also gives you a way to group documents in ImageNow by storing them in drawers and assigning other document key values as necessary. For example, documents scanned from different departments can be placed in corresponding drawers.

After you link documents, you can display the pages whenever you open the corresponding records in your business application. You can also search for documents in ImageNow Explorer and inspect them in ImageNow Viewer. From there, you can export them, print them, annotate them, and add them to workflow.

Link a document or batch

1. On the ImageNow toolbar, click the Applications down arrow and then select the application plan for the business application you want to use to link a batch.
2. On the ImageNow toolbar, click the Batches down arrow and then click Ready for Linking.
3. In ImageNow Explorer grid, select the batch you want to link.
4. On the File menu, click Open and perform the following substeps.
   1. In ImageNow Viewer - Link, identify the displayed page from its name, account number, or other distinguishing information.
   2. In the business application, display the corresponding record.
   3. Position the ImageNow Viewer - Link window and the corresponding business application record so they are both visible on the screen.
   4. Note In a few cases, the entire business application record may need to be visible for linking to work.
   5. On the Batch Link toolbar, click the Link page button to create a link between ImageNow and your business application. The Properties pane slides in from the right side of the window.
   6. In the Properties pane, under Document Keys, enter required values if necessary, and then, on the Batch Link toolbar, click the Save Batch Page button. The next page in the batch is displayed.
5. Repeat the previous substeps as necessary until the entire batch is linked.

About merging

When ImageNow merges two or more documents, it creates a multi-page ImageNow document. The documents that become pages within the merged document are called "source" documents. The final document that you select, when assembling documents to be merged, is known as the "target" document because all of the index values of the source documents are replaced by the corresponding index values of the target document. You cannot merge documents that are marked private or documents that are checked out to another user. Only one member of the merged documents can be in version control, and it must be the target document. A merge also occurs when you append a page to a document in ImageNow Explorer either by scanning the source page or selecting it from a folder.
About modifying document keys and custom properties

In ImageNow, a document key, such as drawer, folder, or tab, holds a value that allows you to file a document in an organized and searchable manner within ImageNow. When you change a document key value in the search grid or in workflow, the effect is to move the corresponding document from one drawer, folder, or tab to another. You cannot change a custom property value from the ImageNow Explorer grid.

Modify document key values

1. In ImageNow toolbar, click the Documents button to open the documents grid.
2. In the documents grid, right-click the document key you want to edit and then click Edit Document keys.
3. Select or enter your change and then press ENTER.

Edit custom properties

1. Open the document.
2. In ImageNow Viewer, if the Properties pane is hidden, on the View menu, click Properties.
3. In the Properties pane, if the Custom Properties list is closed, click the arrows button to open it.
4. Under Custom Properties, type or select a value in the custom property you want.
   
   Note: If a plus box button appears to the left of the property, it is a composite property, where you can type or select a value for each row that appears. For this type of property, you can also add a new set of properties if needed.

5. To add a new row or set, right-click the property name and then do one of the following options:
   
   - If Insert Row appears, click it and then type or select a value in the new row.
   - If Insert Property Set appears, click it and then type or select any values that you want to store in the new set.
   
   Optional. To reset rows to default values, right-click the row you want to reset and then click either Reset Row or Reset Property Set. To remove rows or sets, right-click the row you want to remove and then click either Delete Row or Delete Property Set.

6. When you finish editing data, close the Viewer.

About deleting and restoring documents

ImageNow cannot recover documents that you delete unless your administrator configures the ImageNow File Service agent to preserve deleted documents for a specific time period. During that period you can restore any documents that appear in the My Recycled Documents view or, if you are the ImageNow administrator, in the All Recycled Documents view.
Delete a document

To delete a document, you must have the Drawer Delete or the Document Type Delete privilege for the
drawer or document type that corresponds to the document you are deleting. Your ImageNow
administrator determines whether the system immediately removes documents or moves them to the My
Recycled Documents view. If your system is set to recycle documents, you can restore deleted
documents from the recycle bin if you act within the time period set by your ImageNow administrator.

1. In ImageNow Explorer grid, click the document you want to delete. To select multiple documents,
   hold down the CTRL key while you click the documents.
2. On the ImageNow Explorer toolbar, click the Delete button.
3. In the Delete dialog box, click Yes.

Restore a document

1. To open the recycle bin, in ImageNow Explorer, in the Views pane, open Documents.
2. Depending on your access privileges, do one of the following actions:
   • In the My Recycled Documents view, right-click the document you want to restore and click
     Restore.
   • If you are the ImageNow administrator, in the All Recycled Documents view, right-click the
document you want to restore and click Restore.

Notes

• A restored document keeps the attributes, including version control and association with any projects,
tasks, or workflow queues, associated with it at the time of deletion.
• If another document exists with document key values identical to the document you are restoring,
ImageNow prompts you to either replace the existing document or cancel the restore action. If you
cancel but still need to perform the restore action, you can change the name or type of the existing
document (or ask your administrator to make the change) so that the conflict does not occur.

About sending documents

You can send a document to another ImageNow user by sending it to another user’s ImageNow Viewer,
email system, or fax machine. Each of these methods entails specific prerequisites, options, and
components that are detailed below.

About emailing documents

Three formats are available for emailing a document to another user from ImageNow Viewer:

• ImageNow link – Send an email that contains a document link which the recipient clicks to open the
document in the ImageNow Viewer of the recipient’s ImageNow Client.

• WebNow link – Send an email that contains a document link which the recipient clicks to open the
document in the WebNow Viewer of the recipient’s WebNow Client.
  Note  WebNow link is the only format available when you email a document from WebNow.

• Attachments – Send the document object as an attachment to the recipient in its native format. The
recipient can then view the document using a native application. For example, if you send a
document that is a TIFF, the user can open the attachment using any application that can view
graphics files.
About faxing documents

If you have ImageNow Fax Agent and the TR1034 fax board, you can fax a document to a user. For more information on configuration, refer to the ImageNow Fax Agent install guide. Your ImageNow administrator must have granted you the appropriate privileges to fax documents.

You can send any type of file supported by the ImageNow Viewer. You can fax ImageNow documents to any fax number the administrator configures in the Management Console, or you can enter fax numbers ad-hoc for one-time use.

About sending documents to ImageNow Viewer

You can choose to send a document to other users who are logged into the same ImageNow Server. With this method, the document you send opens in the ImageNow Viewer of the ImageNow Client for the recipients you select. Additionally, recipients can set options to control how the system receives the document, such as whether to display the document immediately, prompt to accept or reject the document, or disable the receipt of any documents sent from other users. Recipients can also choose whether the sent document appears in an existing instance of the ImageNow Viewer window or opens in a new instance of the ImageNow Viewer. You must have the Send Document to User privilege granted at either the Drawer or Document Type level for either the ImageNow Explorer or the ImageNow Viewer.

Export a document to a file

Complete the following steps to export a document from ImageNow or WebNow Viewers to a file:

1. In ImageNow Viewer, select the document or set of documents you want to export.
2. On the File menu, point to Send To, and then click Export this document to a file.
3. In the File dialog box, do one of the following:
   - Select an output profile.
   - Under General, in Profile, select the appropriate output profile you want to associate to this file. ImageNow automatically populates the remaining fields.
   - Enter file settings manually.
     - Under General, in the Directory box, enter the location to export the document or select browse and navigate to the appropriate location.
     - Under Pages, select which pages of the document you want to save to a file.
     - Under Annotations, from the Include list, select one of the following options:
       - Annotations to include annotations with your document.
       - Current view to send the current view of the document.
       - No Annotations to remove annotations from the document.
4. Optional. To modify file settings, click Options. In the File Output Options dialog box, do the following:
   1. On the Content tab:
      1. Under File Generation, do the following:
         1. In Name format, select the format in which you want to name the file.
         2. If you select Custom, in File name, type a name for the output file.
3. Optional. From the Image color conversion list, do one of the following:
   - If you do not want to modify the color of the image, select None.
   - To convert the color images to grayscale before saving, select Grayscale.
   - To convert color images to black and white before saving, select Black and white. This setting is recommended for .tiff images.

2. Under Include, select whether to include sticky notes.

3. Under Header Includes and Footer Includes, select whether you want to include date and time, document keys, or page number.

2. On the Folder Structure tab:

   Note  The Folder Structure tab is only available if you select Individual Files or Multi-page TIFF for each document from the Format list on the Output tab.

   - Click Add to select the properties to create a folder structure for the output files.
   - Click Move Up or Move Down to change the order of the listed properties.
   - Click Remove to remove a property from the list.

3. Click OK to close the File Output Options dialog box.

5. Click OK.
About Retrieving and Viewing

ImageNow contains multiple features to ensure that your information is organized, manageable, and retrievable. An ImageNow administrator can create tailored views so that only relevant documents, projects, or tasks are displayed for a user. When creating a view, an ImageNow administrator can choose which columns appear and customize column labels to tailor the view to a business process. Views remove documents and columns that could otherwise clutter the work space.

You can create and apply public or private filters that allow you to further narrow the documents that appear in the Explorer Grid. You can also perform multiple types of searches to view documents that share a common condition, search for text in a document, or find text in the columns of the Explorer Grid.

What is a condition?

A condition lets you narrow the results returned by a view or an existing public or private filter. Conditions are displayed as rows in the Search tab. A condition is analogous to a true-or-false question. If the answer is true, the document is returned in the search grid when you click the Go button. If the answer is false, the document does not appear.

About document searching

You can perform the following types of searches in ImageNow or WebNow:

- Quick search – Allows you to select single item from a list of possible search filters. You might choose to use this search type if you are attempting to quickly and easily narrow the documents displayed in a view.
- Multiple condition search – Allows you to define multiple search filters and their relationships. You might choose to use this detailed search type to find a specific set of documents that share a set of conditions.

Perform a quick search

A quick search applies a single condition to the documents in the current view and returns the documents or projects that satisfy that condition. You define the condition in the Quick Search tab, which includes the property list, operator list, and value box, shown below.

The set of operators and the method for selecting the value vary with the selection you make in the property list.

1. In ImageNow Explorer, in the Views pane, display a view of the documents or projects you want to search.

2. On the Quick Search tab, define the search condition:
   - In the property list, select the index key, such as Drawer, Folder, or Custom property. This selection sets the property or field in each document that is the basis of the comparison.
   - In the operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   - In the value box, select or type a value to be compared to the document's property or field, using the selected operator.
   - Click the Go button.

3. In the search grid, double-click the document or project you have found to open it in ImageNow Viewer.
Search with multiple conditions

1. In the Search tab, click the Add button.

2. In the Add Condition dialog box, do the following substeps:
   1. In the Constrain by list, click the kind of constraint that sets up the lists you need in the Type, Field, and Operator boxes.
   2. In the Type list, click Normal, Variable, LearnMode, or Prompted.
   3. In the Field list, click the document field that is the basis of the comparison.
      Note If you search on Notes field, ImageNow can search on only the first 50 characters of the field.
   4. In the Operator list, select an operator, such as "is equal to" or "is greater than," that is used in the comparison.
   5. In the Value box, select or type a value to be compared to the document field, using the selected operator.
      Note If you selected Prompted in the Type list, the Message box appears. Enter instructions telling the user what value to enter.
   6. Click OK.

3. Repeat the previous substeps to add more condition rows.
   Note Each new row begins with AND by default. To change AND to OR, click AND.

4. Click the Go button.
   Note If you determine that ImageNow is not evaluating your conditions in the required order, you can select a condition and click the Move Up or Move Down button to reposition it.
Search for text in a document

The search feature described in this procedure is compatible with many common file formats, including DOC, DOCX, HTML, MSG, RTF, TXT, XLS, and XLSX. When viewing PDF documents, you can use the search function provided by Adobe Acrobat to find text.

1. Open a document.
2. In the document, position the mouse pointer where you want to begin the search, right-click, and then click **Find**.
3. In the **Find** dialog box, in the **Find what** box, type the search string and, if you want to refine the search, select either of the following options:
   - **Match whole word only** specifies that the results of the search contain the entire string you entered.
   - **Match case** specifies that the results of the search contain the text you entered, matching uppercase and lowercase characters.
4. Click **Find Next** to highlight each occurrence of the search string beginning at the insertion point you selected. If you reach the end of the document and want to continue searching from the beginning, click **Find Next** again.

Find text in the Explorer Grid

You can find items within the grid that match specified text. Items that match the specified text appear highlighted in the grid.

1. In the **Views** pane, select the view or the filter you would like to search.
2. In the **ImageNow Explorer** toolbar, click the **Open Find bar** button.
3. In the **Find** bar, enter the text you want to find from the items currently in the grid. ImageNow highlights the matching items.
4. Optional. To select the next item that matches your search criteria, click the **Next** button or to select the previous item that matches your search criteria, click the **Previous** button.
5. When you are finished, close the **Find** bar.

**Note** To use the shortcut keys for **Next** and **Previous** buttons, you must display the **Find** bar.

About Views

In ImageNow, a view is a subset of all ImageNow items tailored for you. The view can hide dozens, hundreds, or even thousands of documents that might otherwise clutter your ImageNow Explorer window. Views display only the columns you need to see or work with, including custom property columns. Your view is customized so that the appearance, name, and width of columns in ImageNow Explorer fit your needs.

In addition to document and project views, you may also work with documents and projects in task or workflow views. If your administrator created relationships between documents, you can display the related view at the bottom of ImageNow Viewer. When other ImageNow users transfer documents to you with the Send to User feature while you are connected to the same ImageNow Server, the Recently Received Documents view appears until you disconnect from the server.

When you delete a document or project, if recycled item views are enabled by your ImageNow administrator, ImageNow moves the item to My Recycled Documents or My Recycled Projects. As long as you can see a recycled document or project, you can restore it to its previous view, at which time the document or project keeps the attributes it had before deletion, if possible.
Tip: If you don't see the documents or projects that you were expecting in ImageNow Explorer, click the Go button to refresh the view with any recent changes made by other users or by your ImageNow administrator.

**Types of views**

The following table summarizes the kinds of views available in ImageNow.

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>A project view returns a set of projects. You can open a project view if you have the Use project privilege and the View Projects global privilege. Project views appear in the Explorer Views pane under Projects.</td>
</tr>
<tr>
<td>Related</td>
<td>Related views appear in the Related Documents pane of the document viewer and in the Related Projects pane of the project viewer. A related view applies the relationship selected in the Relationship list to the current document or project. The view displays a list of all documents or projects that satisfy the conditions of the relationship.</td>
</tr>
<tr>
<td>Project Type</td>
<td>When you open a project in a project view, Project Viewer displays a secondary grid that lists the documents in that project. This secondary grid is called a project type view. Because a document can belong to any number of projects, the same document might appear in Project Viewer with different grid layouts, depending on the project type of the project that you open.</td>
</tr>
<tr>
<td>Workflow</td>
<td>A workflow view returns a list of items (representing documents or projects) when you click a workflow process button or a queue button, which appear in the Explorer Views pane under Workflow.</td>
</tr>
<tr>
<td>Task</td>
<td>A task view returns a list of tasks assigned to you according to type of task, such as My Assigned or To Review. Task views appear in the Explorer Views pane under Tasks.</td>
</tr>
<tr>
<td>Recycled documents and projects</td>
<td>When you delete a document or project, if your ImageNow administrator enabled recycled item views, ImageNow moves the item to a system view called My Recycled Documents or My Recycled Projects. If you are an ImageNow administrator, two additional views appear. These views, All Recycled Documents and All Recycled Projects, display all items deleted by all users. As long as you can see a recycled document or project, you can restore it to its previous view, at which time the document or project keeps the attributes it had before deletion, if possible.</td>
</tr>
<tr>
<td>Recently Received Documents</td>
<td>Recently received documents appear in a temporary view that appears when one ImageNow user transfers documents to another user with the Send to User feature. This transfer must occur while both users are connected to the same ImageNow Server. The view sorts the received documents according to the name of the sending user and the time they were sent.</td>
</tr>
</tbody>
</table>
About filters

A filter lets you select a predefined subset of documents or projects from its parent view and simplifies the task of processing a large number of rows in a view. As soon as you click a filter, ImageNow applies the filter to the view and displays the results in the grid.

Private filters

Private filters are visible only to the user who creates the view. If you have the Filter privilege for the selected view, you can create as many private filters as you need. No other users can see your filters unless they have been granted the Manage privilege for the same view.

Public filters

Public filters are visible to all users of a view. Your ImageNow administrator can create public filters along with view definitions. If you want to share a private filter, ask the administrator to convert your filter (which is visible to the administrator) to a public filter.

Create a private filter

You must have the Filter privilege for any view for which you save a filter.

1. On the ImageNow toolbar, click Documents, Projects, or Workflow, depending on the kind of view you want to filter.
2. In ImageNow Explorer, in the left pane under Documents, Projects, or Workflow, select the view to which you will apply the new filter.
3. Perform a search for a document
4. Optional. If your search returned the documents, projects, or items you wanted, click the Save private filter button.
5. Optional. In the Save Filter dialog box, give the filter a name and an optional description and then click OK.
About Workflow

An ImageNow administrator can create a workflow for your documents that coordinates with your business process. ImageNow Workflow lets you route a document through a business process from start to finish with a customizable set of options. You can add a document to workflow, route it to another user’s or group’s queue, respond to alarms and messages about the status of your items, and process it by, for example, viewing or annotating it. With almost any task in workflow, you have more than one way to complete it. Choose the path that best works for you.

ImageNow creates a workflow item for every document sent to the workflow environment. The item points to a document and routes around the workflow environment on behalf of that document.

View an item in workflow

The following steps show how to view an item that exists in a workflow.

2. In ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the workflow grid, double-click an item to open it.

Route an item in workflow

To move an item to a different queue, route the item in workflow.

2. In ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the workflow grid, double-click an item to open it.
4. In ImageNow Viewer - Workflow, verify that this item is the one you want to route to a different queue.
5. On the Workflow toolbar, perform one of the following actions:
   - To send the item to the next queue in the workflow process flow, click the Route Forward button and in the Route Forward dialog box, select the route you want.
     Note When only a single route is defined for the queue, the Route Forward dialog box does not appear and the item is automatically routed.
   - To send the item back to any queue from which it came previously, click the Route Up button.
   - To send the item back to the previous queue, click the Route Back button.
   - To select a queue in the workflow process to which to send the item, click the Route Anywhere button.

Notes

- To send the item to multiple queues in parallel, click Route Forward and in the Route Forward dialog box, under Automatic, select a parallel route.
- To send the item to another sub queue within a super queue, click Route Forward and in the Route Forward dialog box, under Peer Routes, select the sub queue.
Process an item in workflow

To process an item in workflow, the Process privilege is required for the queues you want to work with.

1. Verify that the item is added to workflow.
2. On the ImageNow toolbar, click Documents, and then search for the document you want to process.
3. In ImageNow Explorer, in Documents view, right-click the document you want to process, and then click Open in Workflow.
4. In ImageNow Viewer - Workflow, do one or more of the following actions:
   • View the item
   • Add any annotations
   • Rotate and/or resize the document
   • Apply any other options you want available in the Viewer
5. On the File menu, click Close Viewer, and then return to the ImageNow Explorer.

Add an item to workflow

The following steps show how to add a document or project to a workflow queue.

2. In ImageNow Explorer, on the Simple search tab, set the Search lists and field to the criteria you need to retrieve your document, and then click Go.
3. In the search results, double-click a document to open it.
4. In ImageNow Viewer, verify that this document is the one you want to add to workflow.
5. In the Actions Pane, verify that the Document section is open.
   • To display the Actions pane, in the ImageNow Viewer, on the View menu, click Actions.
   • Click the Document arrows to open the section.
6. In the Document list, click Add this document to workflow.
7. In the Add to Workflow window, select a process, select a queue, select a priority, and then click Add.

Set the status of a document in workflow

1. The following steps show how to change the status of a document to idle, on hold, or pending. On the ImageNow toolbar, click Workflow.
2. In the ImageNow Explorer, in the left pane under Workflow, select the workflow queue you want.
3. In the Workflow grid, double-click a document to open it.
4. In the Workflow grid, right-click the document, point to Workflow and select one of the following options:
   • Mark item as idle
   • Mark item as on hold
   • Mark item as pending
5. In the confirmation box, click Yes.
Perform Actions on a Document

What is a task?

A task is work that you assign to one or more users for documents and projects. There are three task types: document deficiency, pointer, and signature required. You choose the task that best matches the work that needs to be done. The task types are defined as follows:

- **Document deficiency** - Create this task type to indicate when a document is missing or is incomplete.
- **Pointer** - Use this task type to draw attention to a specific document or project location for further action.
- **Signature required** - Assign this task type when a user needs to digitally sign a document. You must have the Document Management Suite license installed on your ImageNow system for this task type to be available.

Several task views are available in ImageNow Explorer that allow you to optimize task viewing and processing. The following views run automatically when selected: My Assigned, To Review, Returned to Me, Complete Pending Review, and Returned by Me. The task results you see are based on your task role. For example, if you are a reviewer, when you select To Review, tasks that require your review appear. If you are not a reviewer and you select To Review, the system returns no results. You can customize the task startup and processing options for the My Assigned view.

What is an annotation?

You use an annotation in ImageNow to mark up and comment on a document without affecting the original image. You can position annotations where you need in the document. ImageNow offers many types of annotations so you can express the different points you want to make. For example, in ImageNow, you can express your review of a document by stamping it approved, signing off on it using a pen, or adding a check mark. You can also add sticky notes to add small notes to a document object, either inline or as a global comment on the document. In the ImageNow Client, you can add annotations on the following file types: TIFF, BMP, and JPG. In WebNow, you can add annotations to TIFF, BMP, JPG, GIF, and PNG files.

Each ImageNow annotation requires an annotation template that your administrator creates for any supported annotation type. Security options are also available based on the template. For example, you can create a Stamp template with the following text: “Received by Accounts Payable”. Your ImageNow administrator can set the template security so that only users in the Accounts Payable group can use, modify, or delete annotations created using that Stamp template. If your ImageNow administrator does not grant ImageNow users in the Human Resources access to view stamps created using that stamp template, those users cannot view, modify, or delete this annotation. Contact your ImageNow administrator if you need new annotation templates.

Add an annotation

You use an annotation in ImageNow to mark up and comment on a document without affecting the original image. Complete the following steps to add an annotation to a document.

1. In **ImageNow Viewer**, open a document.
2. On the **Annotations** toolbar, right-click the annotation button you want and select the form of the annotation from the list.

   **Note** The **Sticky Note** and **OLE** buttons require only a left mouse button click.
3. Click and hold the mouse button on the document image where you want to place the annotation.
4. Drag the annotation, as necessary, over the target area and then release the mouse button.

**Hide annotations**

Hiding annotations enables you to view the original unmarked document without deleting the annotations.

1. Open the document with the annotations you want to hide.
2. In **ImageNow Viewer**, on the **Annotation** menu, click **View** and then do one of the following actions:
   - To hide an annotation type, clear the corresponding check box.
     
     **Note**  To show an annotation type, select the corresponding check box.
   - To hide all annotations, clear the **All** check box.
     
     **Note**  To show all annotations, select the **All** check box.

**Note**  Closing the document with the annotations hidden does not delete the annotations. When you reopen the document in ImageNow Viewer, all annotations are shown automatically.

**About redaction**

Redaction is the act of removing sensitive, private, or confidential information from a document in a way that hides that information without distorting the meaning of the document. You can use a redaction on a document to alter a version of a document so that you remove any possibility of users seeing the confidential information covered by the redaction. So, the redacted version of the document is the one in the system that is more universally available. At the same time, the original document stays in the system as your legal record, so that it is available for auditing, assessment, or litigation purposes. You can store the original document in a highly secured area of your system.

A redaction is a solid, rectangular graphic that covers a portion of document so that the information it covers is no longer visible to the user. For example, you can redact a tax identification number or a social security number from a document so that it no longer appears on a redacted document. The difference between a redaction and a filled, rectangle annotation is that, at times, a delay might occur as the annotation renders on the document where the information covered by the annotation might be visible to the user. Unlike an annotated document, if you have Content Server and send a redacted document to it, the Content Server does not capture the area behind the redaction so a user cannot accidentally find the redacted text in a full-text search. In addition, the thumbnail image of the document that appears in the Viewer also displays the redaction, blocking the confidential information.

When you generate redacted documents, we recommend that you put the redacted documents in separate drawers from the original documents and apply security on the drawer level. Additionally, you can set the redacted documents to a separate document type from the original document type and specify security by document type. Contact your ImageNow administrator if you need new templates for redactions.

You can add redactions to documents using ImageNow Client or WebNow. After you save a redaction to a document in ImageNow Client or WebNow, you can add annotations to the document. However, in ImageNow Client, if you open a document that was redacted in WebNow, you cannot add annotations to the document or view any annotations added to the document through WebNow after the redaction, and the thumbnail image appears dark.
Add a redaction to a page

Redaction is the act of removing sensitive, private, or confidential information from a document in a way that hides that information without distorting the meaning of the document. You can use a redaction on a document to alter a version of a document so that you remove any possibility of users seeing the confidential information covered by the redaction. Complete the following steps to add a redaction to a document.

1. In ImageNow Viewer, open a document.

2. On the Annotations toolbar, right-click the Redaction button and then select a redact annotation from the list.

3. Beginning at one corner of the area where you want to start the redact rectangle, drag a rectangle.

4. Release the mouse button at the endpoint of the redact rectangle.


6. In the Save Redaction dialog box, add a key to describe the redaction. For example, in an empty key field, type Redaction, and then click OK. This action saves a copy of the document that shows the redaction.

7. Click OK.
Additional Functionality

This section describes functions of ImageNow that are additional to the basic installation and require additional licenses. Each of the following features requires a separate license. Contact your Perceptive Software representative for details about how to obtain one or more licenses and for these products.

Document Management

ImageNow Document Management gives you the ability to place documents into version control in ImageNow, and then manage changes to a document during the content authoring process while ensuring the integrity of your documents at all times. Document management also works with other ImageNow features such as its annotations, search, auditing, and workflow. After editing a document, for example, you can then send it through workflow for review, approval, and signing using digital signatures. For more information about Document Management, refer to "Getting Started with Document Management".

About forms

Your ImageNow system might include ImageNow eForms. Whether you can use forms depends on your implementation of ImageNow. Depending on your system configuration, a form appears attached to a document in the Forms pane, or as a standalone document or project in the ImageNow Viewer. To determine if you have forms available in your implementation, contact your ImageNow administrator. Your administrator can tell you which forms are available, including any workflow queues with which they are associated.

You complete a form by typing data into the fields on the form. Form data might also be pre-populated by other ImageNow components. To use forms, you must have certain security privileges. Contact your ImageNow administrator to obtain the privileges necessary for viewing, entering, modifying, and deleting form data. For more information about forms, refer to "Forms Getting Started Guide".

What is Business Insight?

ImageNow Business Insight allows you to showcase your ImageNow data using a ready-to-run library of reports as well as the reports created by a Business Insight Author user. In Business Insight, you can view, run, schedule, and archive instances of the reports used in your enterprise. Flexible output allows you to run, view, and save instances of a report as an HTML page, a PDF document, a comma-separated file (CSV), an XML file, or as a Microsoft Excel spreadsheet. You can then distribute instances of the report instantly using email, shared file locations, or FTP.

Business Insight is an optional component of your ImageNow system and requires a Business Insight license. When this component is installed and configured, every user in your enterprise can run and view reports. Users with the Manage Reports privilege determine the reports you can access and the actions you can perform for each report in Business Insight. For more information about Business Insight, refer to "Getting Started with Business Insight".

About using retention

With Perceptive Software's retention functionality, you can manage the lifecycle of your organization's documents. As documents move through the lifecycle of a retention policy, you can determine whether a document is under a protected phase, assign physical file references, approve disposition actions, and apply document holds.

You can use the retention columns in ImageNow Explorer to view documents that fall under a policy, documents that fall under a protected phase in a policy, and documents that are associated with a physical file reference. Retention columns are available for the documents, projects, and workflow views.
To track the physical location of a document, you can create a physical file reference. For example, you can designate a warehouse, shelf number, or box number as a physical location. You can create a physical file reference for any document in your system from ImageNow Explorer and ImageNow Viewer.

If a policy creator designates you as an approver, you must approve the path disposition action, such as destruction, offline transfer, or accession, before that action can occur for the documents that fall under that path. When the retention period ends, Retention Policy Manager automatically creates an approval task for you. To approve the disposition action, you simply approve the approval task. You can view the approval tasks assigned to you in the My Assigned Tasks view.

A hold allows you to preserve a document. When you apply a document hold, no changes to that document can occur until you remove that hold or the hold expires. You can search for documents that are currently under a hold from ImageNow Explorer. In addition, you can view the hold history for all documents. For more information about Retention, refer to “Getting Started with Retention Policy Manager”.
Index

Actions pane, 9
administrator role, overview, 4
annotations, 25
    adding, 25
    hiding, 26
application plans
    in Views pane, 8
Applications
    ImageNow toolbar button, 6
batch mode
    capturing, 11
    scanning, 11
batches
    in Views pane, 8
    quality assuring, 12
    toolbar button, 12
Batches
    ImageNow toolbar button, 6
Business Insight, overview, 28
Capture
    ImageNow toolbar button, 6
    WebNow toolbar button, 7
capturing documents
    batch mode, 11
    single mode, 11
Commit batch, QA button, 12
composite properties overview, 10
conditions, overview, 18
Content Search Results pane, 9
custom properties
    modifying, 14
    overview, 10
Delete batch page, QA button, 12
developer role, overview, 4
Digital Signatures pane, 9
document keys
    modifying, 14
document keys overview, 10
document processing overview, 11
documents
    deleting, 14
    e-mailing, 15
    exporting, 16
    faxing, 16
    in Views pane, 8
    overview, 5
    restoring, 14
    sending to Viewer, 16
    viewing, 18
    WebNow toolbar button, 7
diff end-user role, overview, 4
Explorer window, overview, 7
file formats and pages, 10
filters
    creating, 22
    overview, 22
    private, 22
    public, 22
Forms pane, 9
forms, overview, 28
ImageNow
    overview, 4, 5
    toolbar, 6
    Viewer, 9
index keys overview, 10
linking
    batches, 13
    documents, 13
    overview, 13
manage
    ImageNow toolbar button, 7
Management Console, function, 5
Mark page as OK, QA button, 12
merging overview, 13
multiple condition search
    overview, 18
    performing, 19
pages
overview, 10

panes

Actions, 9
Content Search Results, 9
Digital Signatures, 9
Forms, 9
in View menu, 9
Page, 9
Properties, 9
Related Documents, 9
Tasks, 9
Thumbnails, 9

processing documents overview, 11

projects

in Views pane, 8
overview, 5
WebNow toolbar button, 7

Projects

ImageNow toolbar button, 6

Properties pane, 9

quality assuring

batches, 12
documents, 12
icons, 12
overview, 12

quick search

overview, 18
performing, 18

redaction

adding, 27
overview, 26

Related Documents pane, 9

reports

ImageNow toolbar button, 6
in Views pane, 8
WebNow toolbar button, 7

Rescan page, QA button, 12

retention, overview, 28
scanning overview, 11

searching

for document text, 20

single mode

capturing, 11
scanning, 11

Suspend batch, QA button, 12

task

document deficiency, 25
pointer, 25
signature required, 25

tasks

ImageNow toolbar button, 6
in Views pane, 8
overview, 25
WebNow toolbar button, 7

Tasks pane, 9

terminology, 6
text search, 20

Thumbnails pane, 9

views

overview, 20
types of, 21

WebNow

overview, 5
toolbar, 7
Viewer, 9

workflow

adding items, 24, 25
ImageNow toolbar button, 6
in Views pane, 8
overview, 23
processing in, 24
routing in, 23
WebNow toolbar button, 7